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1 Introduction

1.0 What is Zotero?

Zotero is a free tool that facilitates the collection, organisation and use of references and citations found online. It is one amongst a number of easily-accessible ‘citation management’ tools; competitors include EndNote, Mendeley, RefWorks and a number of others. Each has their strengths, but a number of qualities – not least that it is a free download – have made Zotero a popular choice. 

It was first created as a plugin for the Firefox web browser and could not be used independently, but for the last three years it has existed as a fully-fledged program in its own right. However, it must be used in conjunction with a web browser. Currently the ‘connectors’ necessary for Zotero are available for the Firefox and Chrome browsers on PCs and for Safari on Macs. Although they are promised, there are as yet no connectors for MS Edge.

Zotero includes all the functions that are standard in citation management software. Whilst browsing the web, Zotero allows items to be added to your collection of references in a variety of different ways. In some cases – for instance, while using an online bibliography – it adds icons which, when clicked, will save all bibliographical details of a book or paper to your lists. Alternatively, items may be added by typing in the ISBN (Zotero will automatically retrieve all the relevant information from online sources) or by entering the full details of the item manually. It allows files, web pages and links to be downloaded and attached to references or to stand as references in their own right. Having populated your Zotero library with references, its contents can then be organised into groups and notes and tags can be added. Finally Zotero integrates with Word, Libre Office, Google Docs and other word processors through plugins to provide a fully featured citation-while-you-write function, supporting a very wide range of referencing styles and automatically generating bibliographies.


1.1 Installing Zotero

Obtaining Zotero

Zotero can be downloaded for free from http://www.zotero.org/. At the same time as you download the program itself you will need to download and install ‘connectors’ for the browser with which you intend to use it; Zotero supports Firefox, Chrome and Safari. The website should automatically detect the browser with which you are downloading and provide the correct connectors automatically, but if for any reason you require different or additional connectors for another browser, these can be downloaded later: see the website for details.

[image: ]

Zotero and Word Processors

To enable Zotero to function together with word processors to produce properly formatted documents, plug-ins for the word processing package in question need to be installed. They are bundled with the main program and should be installed automatically for every wordprocessor present on your computer at the time when you install Zotero. If necessary they can be reinstalled manually from within the Zotero Preferences dialogue box. Open Zotero Preferences using the Edit drop-down menu. Select Cite and make sure that the Word Processors tab is selected.

[image: ]

Add-ins for MS Word and for OpenOffice.org/LibreOffice/NeoOffice are available. Make sure that the one(s) you need is installed and press OK.

















1.2 Support and training

A great deal of support material is available on the Zotero website in the Support section (http://www.zotero.org/support/), including video tutorials on many different aspects of using Zotero.


[image: ]

Try also searching on Youtube for Zotero training videos or go to: http://www.youtube.com/user/ZoteroVideo.

[image: ]



1.3 Registering for an account

To make proper use of Zotero you must register for an account. It is by this mechanism that you will be able to use your Zotero libraries on a number of different computers or to use the groups capabilities of Zotero.

To register, go to https://www.zotero.org/user/register
 [image: ]

Complete your details and press Register. An account will be set up in the cloud in which all your references and associated material will be stored. It you intend to use Zotero on more than one computer you will need to make sure that Zotero is installed on each of them and that you are logged in to your account. You may also need to log on to use certain parts of the Zotero website such as, for instance, the forums.

Storage Limits

Free Zotero accounts come with 300 MB of cloud storage space, which should be adequate for basic needs. However, if you are a heavy user, and particularly if you are storing a lot of files (pdfs or images) along with your references, then you may need more room: this can be purchased at the Zotero website at https://www.zotero.org/storage. 2GB costs $20/year, 6GB is $60/year and unlimited storage is $120/year.

2 Finding your way around Zotero

2.0 Basic appearance


			Menu Bar				Button Bar

[image: ]



File & Groups Management Pane	Library Pane			Bibliographical Details Pane


Start Zotero from your Start button or from a desktop icon in the normal way. Note that for the capture functions of Zotero to work in your browser of choice Zotero must be open and running, although for the sake of tidiness you may prefer to keep it minimised and out of the way.

Zotero has all the typical elements of a Windows program. At the top is a drop-down menu bar, below it a buttons bar and, below that and occupying the majority of the space is the main workspace, which is divided vertically into three panes. We shall examine each of these elements in turn in sections 2.1 The Menu Bar, 2.2 The Buttons, and 2.3 The Panes.
2.1 The Menu Bar

[image: ]

The menu bar contains five drop-down menus – File, Edit, View, Tools and Help – containing various controls and options. Some commands will be familiar from other Windows programs, but others are peculiar to Zotero. There are often several ways of performing the same action, using menu options, mouse clicks or buttons.

2.11 The File Menu

[image: ]

New Item
Adds items to your library manually (see below). You may also use the New Item button [image: ] on the button bar.

New Note
Opens the Note dialogue box to allow a note to be written. This can be attached to a particular item in the library or may exist as a standalone, unconnected to any individual item. You may also use the New Note button [image: ].

New Collection
Creates a new collection (see section 2.2 below). You may also use the New Collection button [image: ].

Close (Ctrl + W)
Closes Zotero.

Import…
Opens a standard Windows Import dialogue box from where a file on your computer or the cloud can be selected to be imported into Zotero. Normally this import function is only used to bring existing bibliographies created in other programs and formats (from EndNote, for example) into Zotero (NB, bibliographies created in Word or other word-processing packages cannot be imported directly into Zotero, although it may be possible to import them if they are first converted into an intermediary bibliographic format, such as a RIS file).

Import from Clipboard
Similar to Import… but brings the contents of the Windows clipboard into the Zotero library.

Export Library…
Exports an entire Zotero library or – if items within a library are selected – those individual items for use on another computer. Note, however, that this is not an option recommended by the makers, and may result in problems, especially if PDFs, notes or other files are attached to your library.

Exit
Closes Zotero.

2.12 The Edit Menu

[image: ]

Undo, Redo, Cut, Copy
Standard Windows operations

Paste, Delete, Select All, Find
Standard Windows operations

Advanced Search
Opens the Advanced Search dialogue box, allowing more complex searches to be run on the library.

Preferences
Opens the Preferences dialogue where many aspects of the performance of Zotero can be configured.

2.13 The View Menu

[image: ]

Layout
Allows the appearance of Zotero to be configured and the visibility of various panes in the window to be toggled.

Font Size/Note Font Size
Changes the font size of the program

Show Items from Subcollections
Toggles whether subcollection items are displayed.

2.14 The Tools Menu

[image: ]

Create Timeline
Creates a ‘Timeline’ from the given collection, which is simply a means of visualising and comparing the relative dates of composition or publication of the items that comprise it

RTF Scan…
RTF Scan is a quick means of creating a properly cited document without having to use the word processor plugins.

Install Browser Connector
Installs connectors for various types of browser if they are not already present.

Add-ons
Clicking on Add-ons opens the Add-ons Manager dialogue. Here the various auxiliary programs and applications that associate Zotero with browsers, word processors and other programs are described and can be managed and altered.

Developer
Provides access to a number of advanced options for developers.

Manage Attachments
Provides access to attachments associated with a reference when these are present.


2.15 The Help Menu

[image: ]

Support and Documentation
Opens the Zotero support and help documentation in a web browser. Can be found directly at: https://www.zotero.org/support/.

Troubleshooting Information
Opens Zotero’s troubleshooting page at: https://www.zotero.org/support/getting_help.

Discussion Forums
Opens the Zotero discussion forums at: https://forums.zotero.org/

Report Errors…
As an open-source project, Zotero strongly encourages its users to participate and share their knowledge and experiences with others. Errors are automatically noted but by using this option an error ID will be created which can then be used to reference the problem in posting to the Zotero forums.

Check for Updates…
Connects to the Update Server to download and install any pending updates to the program.

About Zotero
Displays version information and credits.



2.2 The Buttons

[image: ] New Collection…
Use this button to create a new collection (see section 2.2 below). Collections are a way to organise your library of references into groups for particular research topics or papers or chapters. Pressing the New Collection… button opens a dialogue box where you will be prompted to provide a name for your new collection. Once this is provided the collection will appear in the file management pane on the left of your screen and items may be added or removed as described in section 2.2.

[image: ] New Library…
Opens the New Group… and New Feed options.

Groups in Zotero are a way of allowing access to your libraries of references to other people: this might be for a collaborative publication or to share a reading list or bibliography. Groups lie outside the scope of the present tutorial, but you may learn more about them by searching on the support section of the Zotero website.

Feeds are a way to discover new research. With feeds, you can subscribe to updates from a journal, website, publisher, institution, research group, or other source and quickly find new articles or works. Though this is not yet widely implemented, it may become more useful in the future.

[image: ] New Item
Use this button to add new items to your libraries manually, i.e. by typing in the details rather than by harvesting them from a web page. Clicking on the button opens a drop-down menu that offers by default the most commonly-used item types (Book, Book Section, Document, Journal Article, Newspaper Article). Select the one which is most appropriate for the item that is to be added and a blank item of the selected type will open in the central panel of your Zotero screen (see section 2.1 below). A full (and much larger) list of item types is available by clicking More at the bottom of the drop-down menu.

[image: ] Add Item By Identifier
A quicker means of adding new items without having to type in all the details by hand. Given an identifying number using one of three internationally-recognised coding systems, Zotero consults online databases and retrieves the complete bibliographical record for the document, article or item in question. To use this you will need to enter the ISBN (for books), the DOI (Digital Object Identifier: mostly for articles stored electronically) or PMID (for items stored on the PubMed database of biomedical and scientific publications.

[image: ] New Note
Zotero Notes are a means of adding your own comments, thoughts or overviews of an article. Clicking this button while an item is selected opens a Note dialogue, into which you can type whatever it is you wish to say. This will then be saved as an attachment to the item. Alternatively notes can exist as standalones and not connected to an individual item.

[image: ] Add Attachment
Use this button to attach files (e.g. pdf copies of articles) to an item.

[image: ] Advanced Search
The Advanced Search button opens a dialogue box providing access to the full range of search options and allowing, for instance, detailed searches that are restricted to one specific field of your Zotero library.

[image: ] Search Box
The Simple Search Box is for quicker searches where the need to specify the search terms with precision is less important than easy and simple access.

[image: ] Locate
Locate is used to attempt to find full-text copies of items in your library that are available online as pdfs or in other file formats. These may then sometimes be downloaded into your copy of Zotero and saved as attachments to the item. The Locate tool works using various scholarly search engines, including WorldCat and Google Scholar, and it may be that you choose to use several of these in attempting to secure copies of your items. Note, however, that results can be rather mixed and that it is frequently impossible – at least for the time being – to obtain copies of articles without payment.

[image: ] Sync
The Sync button synchronises the copy of your library stored locally on your computer with the version that is held in the cloud. Zotero syncs automatically when you log in or log out, but if you have done some work that you need to be reflected in the cloud copy of your library – if, for instance, you had made some changes to your library and then wanted to use these when producing output in a word-processed document – then it may be useful to apply manual syncing as well.



2.3 The Panes

[image: ]

The screen is divided into three panes. On the left is the file and groups management pane. In the middle is the main library pane, where items from the currently selected group are displayed, one per line. The pane on the right displays the full bibliographical entry for the item currently selected.

2.31 The File and Groups Management Pane

[image: ]

The upper part of this pane is devoted to file management, and is where collections can be managed. Collections are represented by a folder icon; collections can be further divided into sub-collections in a hierarchical structure (see section 2.2 below)

The lower part of the pane is the tags area, where a list of all tags that have been applied to items is given. One or several can be selected by mouse clicks: doing so automatically filters what is shown in the main library pane by that criterion. Tags can be deselected again by a further mouse click.

2.32 The Library Pane

[image: ]

This pane displays a list in summary form of all items in the current library, one per line, or, if filters have been applied, the relevant items meeting the selected criteria. By default, four fields of the bibliographical information are displayed: an icon to represent the nature of the item (book, chapter, paper, web page etc); the Title (in short form), the Creator (normally the author) and a field that displays a blue dot if attachments (PDFs, for instance) are present.





2.33 The Item Pane

[image: ]

This pane provides a choice of four tabs:
(i) Info opens by default and provides the full bibliographic information for the currently-selected item
(ii) Notes displays any notes associated with the current item unless none are present, in which case a button appears to add a note.
(iii) Tags displays any notes associated with the current item unless none are present, in which case a button appears to add a tag
(iv) Related shows any other items which have been marked as related to one another (a review of a book, for instance). Again, a button is available to relate items to each other.






3 Basic operations

This section will first explain (in part 3.1 Creating, editing and deleting items) how to add items to your Zotero library; the easiest way is to add them automatically from online bibliographies and library catalogues while using a web browser, but you should also learn how to add things manually, by typing in the relevant details. Once you have items populating your library, you will probably want to arrange them into reading lists or bibliographies for particular projects or articles or chapters. This is explained in section 3.2 Arranging and gathering items: collections. Another approach to making your libraries more useful and versatile by tagging your items with keywords is explored in section 3.3 Arranging and gathering items: tags.

Using Zotero, it is also possible to associate a PDF with a given item: in this way you can, for instance, keep an actual full-text copy of an article together with its bibliographical details, transforming Zotero from a simple citations management tool into a very powerful database of your secondary research materials. Adding PDFs in this way is covered in part 3.4 PDFs and other files.

Finally, you can also create standalone notes in Zotero, which can be associated with a given reference. This is covered in part 3.5 Notes. Using this and the PDFs function, it is possible to store in an easily accessible format not only your complete bibliographical listing, but also both full text copies of your sources and any notes that you may have written about them.

3.1 Creating, editing and deleting items

Every reference to a book, article, web page or whatever is called an ‘item’ in Zotero. Items may be added in a number of different ways.

Probably the easiest way to add items is to capture them from the web whilst using a browser. This can be done quickly and easily using function buttons that Zotero adds to your browser’s address bar. These are of two types: the book icon and the folder icon, each of which we shall look at now.

Adding single items using the book icon
When the currently-open web page contains bibliographical information about a book, article or other reference that might potentially be imported into Zotero, an icon will appear at the right-hand side of the address bar: Zotero detects when any such data are available. The icon in the address bar may take any one of a number of appearances, depending on the type of item which is available for harvesting on the page.

[image: ]
							The book icon

Click on the icon and the full record for the book will be saved into your Zotero library.

Another frequently encountered icon is the journal article ([image: ]), and you will also often see the folder icon ([image: ]), which indicates that more than one bibliographical item is available on the current web page (explained below in the Adding multiple items using the folder icon section).

Exercise
To illustrate how this function works, we shall add an item from the British Library. In your web browser go to www.bl.uk. 

[image: ]

From the black bar across the middle, select Catalogues and then Explore the British Library (56m items). This opens the BL Explore system, which is the principal BL catalogue. Type a book title or an author’s name into the search box and press the red Search button at the right. For this example I have used The Stripping of the Altars:

[image: ]

The catalogue returns a number of results. Note that a yellow folder icon appears at the right of the address bar:

[image: ]

This happens when there are multiple items onscreen that contain a bibliographical record, but at the moment we are trying to pinpoint a single item, so for the time being I ignore that and instead click on the third result offered by the BL catalogue, which is the book The Stripping of the Altars by Eamon Duffy, which opens the full entry for that work:

[image: ]

Note in the browser’s address bar that the folder icon has now turned into a blue book icon, [image: ]. Left-clicking this saves the full bibliographical record of the item in question to your copy of Zotero; a notification box will appear for a while towards the bottom right of your browser to acknowledge that this has occurred successfully. Go to Zotero to make sure that the item has now appeared in your library: the most recently-saved item will be selected by default:
[image: ]

Adding multiple items using the folder icon

If the bibliographical details of a number of different items are available on the current page – if, for instance, you have run a search on Google Scholar, which has returned a list of hits – then the icon at the right of the address bar will be a folder.

[image: ]
							The folder icon

Clicking on this will open a list of items with check boxes: select those you wish to save and press OK. The items you have chosen will be captured and imported to your Zotero library.

Exercise
A very powerful use of Zotero is to gather material for reading lists by running searches on online bibliographies or other search tools and exporting large numbers of records at once. We can explore this using the Bibliography of British and Irish History (BBIH), to which Senate House Library has a subscription. If you are within Senate House go to www.brepolis.net in your browser and click on [image: ]. Under Free-Standing Databases select the Bibliography of British and Irish History
[image: ] 
and the BBIH main page will open.

To access BBIH from home or elsewhere outside Senate House go to the list of e-resources at:  https://london.ac.uk/senate-house-library/our-collections/databases-and-eresources/eresources-a-z#a-to-z--B. Click on Bibliography of British and Irish History
[image: ]
You will need to use your usual SHL e-resources details to log in (normally your name and your library barcode number: see SHL for details). This will open the BBIH main page.

Whichever way you have accessed BBIH, the page you have opened looks like this:

[image: ]

Type a search term into the ‘Search Anywhere’ box; for current purposes, we will use ‘Sutton Hoo ship burial’ as the search term, in order to compile a reading list on the seventh-century Anglo-Saxon cemetery in Suffolk. The BBIH returns 30 hits using that search term:

[image: ]

I can see the details of those hits by pressing the [image: ] button. BBIH then lists them all, spread over two pages. Note that the yellow folder icon [image: ] appears at the right of the address bar, indicating that multiple item details are available to download. Clicking on the icon opens the Zotero Item Selector dialogue box:

[image: ]

Here you may choose which of the available items from the page to download by selecting or unselecting the check-box next to their name. Once you are happy click OK and the items will be downloaded to your Zotero library.

Note that, of the 30 items found by my search in BBIH, only 20 are available in the Zotero Item Selector box that I have just produced. This is because the BBIH results were split over two pages for clarity and the Zotero box has only detected those found on the first page. To download the rest of the results I must access the second page and then press the [image: ] icon again.

Adding web pages as items

Zotero will capture and retain a copy of any web page exactly as it was when found. If no bibliographical data are available on the current page, the icon found at the right of the address bar ([image: ]) will be the Save to Zotero (Embedded Metadata). Clicking on this downloads a copy of the page to your library.


Manually Adding Items

To add items by hand, click on the New Item icon ([image: ]), which can be found in the middle of the Zotero window in the middle of the toolbar. Select the type of item to create from the options in the drop-down menu: the more common types – Book, Book Section, Document, Journal Article, Newspaper Article – are listed automatically, but others are available by clicking More at the bottom of the drop-down. A blank item of the selected type will open in the centre column: click on any field to select it and then type in the relevant values.

Items can also be created by selecting File/New Item.

Deleting Items

Zotero items may be deleted by right-clicking on them in the library pane and selecting Move Item to Trash:

[image: ]




3.2 Arranging and gathering items: collections

Once you have some items in your Zotero library, you will probably start wanting to arrange them into groups in order to help you keep track of what you are using where. The best means of controlling and keeping track of items in a Zotero library is to organise them into collections. Each collection will probably correspond to a particular research project or topic or thesis chapter, but collections are very flexible and may be created, combined, divided or removed as need dictates. The left-hand pane of the Zotero window displays the collections that you have created, arranged hierarchically in a folder structure, if you so choose.

Note that a single item may be in multiple collections at the same time: so, for instance, the book The Victorian Celebration of Death might be placed at the same time in the collections ‘Nineteenth Century’ and ‘Death Rituals’, which could be used for different purposes. All items will appear once in ‘My Library’, which is the complete and definitive master-list of all your records. Any item that is deleted from ‘My Library’ will be removed entirely from all collections of which it is a member.

Creating a New Collection

Click on the New Collection button ([image: ]) above the left pane and, when prompted, give your new collection a name. Whilst the collection is selected, all items imported to Zotero will be added both to that collection and to ‘My Library’. Items may also be added to a collection by dragging and dropping them from the centre pane to the name of the collection in the left-hand pane.

Adding Sub-Collections

Sub-collections within collections may be created by dragging a new or existing collection into another collection in the left-hand pane of Zotero. Alternatively right-click on the collection within which you want to create your sub-collection and select [image: ]

Re-naming or Deleting a Collection

Collections may be re-named by right-clicking and selecting Rename Collection…

To delete a collection, again right-click, but select Delete Collection. Note that this only deletes the collection: the items contained within it will remain in your ‘My Library’. By right-clicking on a collection and selecting Delete Collection and Items… you will both remove the collection and all the items within it from your ‘My Library’.



3.3 Arranging and gathering items ii: tags

Tags represent a different approach to organising and arranging your items. You may tag any item with any number of relevant keywords which describe it; these may then be used to group together or separate off items relevant to a particular subject.

Adding Tags

Tag items by selecting the [image: ] tab in the right-hand pane and pressing the [image: ] button. Type the name of your tag and press return. The tag will be added in the right-hand pane, indicating that it has been added to the selected item, but note also that it will appear in the tag selector box at the bottom of the left-hand pane, from where groups of items sharing a tag can be selected, as described in the following section.

Using the Tag Selector Box

The tag selector box, at the bottom of the left-hand pane of Zotero, contains all the tags that you have created for items in your library. Click on any tag to filter the items displayed in the central panel to include only those which have been given that tag. Note that by selecting multiple tags you may filter by several different criteria at once. Deselect tags that are no longer needed by clicking on them again in the tag selector box and the items displayed in the central pane will update correspondingly. Alternatively click the Actions button ([image: ]) and click on Deselect All to remove all tag filters and leave the centre pane displaying all items in the selected folder.

The tag selector box may also be used to control and edit all of your tags at once. Right-clicking on any tag opens a drop-down menu with three options which will be applied to this tag on every item in which it occurs: Assign Color…, Rename Tag… and Delete Tag…. The two latter options are self-explanatory; Assign Color… will cause a coloured dot to appear next to items in the centre pane that have been assigned the tag in question. Up to six tags may be given a colour in this way.

It is possible to assign a tag to a number of items at once by selecting the desired items in the central pane and then dragging them on to the correct tag in the tag selector box.

Automatic Tags

Some items that you save will come with tags already attached: Zotero often automatically imports such classification information along with the more straightforward cataloguing details of an item. You can toggle whether these automatic tags should be included in the display in your tag selector box using the Show Automatic option on the Actions button.

Using Collections and Tags

You will find your own ways to categorise and arrange your library using tags and collections. Any given Zotero user might prefer one to the other, or might use each of them but for different purposes: tags are generally used to provide thematic information, whilst collections are more likely to be used to keep together and in one place all of the references that have been used in a particular article, chapter or other piece of work.



3.4 PDFs and Other Files

Zotero allows you to store PDFs and other files along with your references. 

[bookmark: adding_pdfs_and_other_files]Adding PDFs and other Files

To include a PDF or any other file from your computer in Zotero, simply drag it to Zotero - you can drag to an existing item to attach the file or drag between items to store as an independent item.

Exercise
To practise attaching a PDF to an article, we need a PDF. Go to Senate House Library by entering senatehouselibrary.ac.uk into the address bar of your browser. Scroll down the screen until you find the Search Library Catalogue search box. Ensure that you are searching for journals by selecting ‘Periodical Title’ in the Seach By drop-down menu and then enter the name of a suitable journal into the box and press Rtn. Try ‘English Historical Review’ if you cannot think of an appropriate journal. Find the online version of your journal (stored, perhaps at JStor or a publisher’s website), select an article and download it to your computer, saving it, for convenience, to the desktop. The desktop icon representing the PDF can then be dragged and dropped into your Zotero library; if it is dropped on top of an existing reference, then it will be saved as an attachment associated with that reference; if it is simply dropped into the library, away from other references, it will be saved as an item in and of itself. Zotero will automatically attempt to retrieve metadata for that item online and populate a reference entry, which will thus become a standard Zotero item with attachment.



3.5 Notes

Alongside references, Zotero allows the creation of notes; these may be attached to particular references to stand as a commentary or may exist as standalone items in their own right.

Creating Notes

To attach a note to an item, select the item in the central library pane. Its full entry will appear in the right-hand pane. Click on the Notes tab and then press the Add button:

[image: ]

The Notes editor will open in the right-hand pane:

[image: ]

Type your note into the space. This is a relatively sophisticated text editor with a variety of formatting options and thus allows quite long and complex notes to be written. Text is saved as it is typed, so the window may be closed at any time (normally by clicking on another reference within Zotero) and everything typed in the note will be retained. Thereafter the note will be associated with the item and may be accessed for further editing by clicking on its entry in the central Zotero pane.

To create a standalone note, click on the New Standalone Note icon [image: ] or select File/New Note from the drop-down menu bar. This opens the note editor, as above, where the note can be entered. Upon completion the note is saved as an item that is complete in itself and not associated with any other item. It may be accessed for reference or editing by clicking on it.


Dr Simon Trafford
27 February 2020
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